
What is Lexica?
Lexica is a software product to help people learn and teach foreign languages.  It is designed
for use in beginning college and high school foreign language classes and for home use.  Its 
three main tools emulate:

1) a foreign language textbook/workbook
2) a bi-directional foreign language dictionary
3) flash cards.

Each of these tools has many features that are not available with their physical 
counterparts, such as digitized sounds, modifiability, and interconnectivity.

Lexica is designed to run on any Apple Macintosh computer.  All the language-specific data is
separate from the actual program, so it can be used with virtually any two languages.  For 
example, with one set of data files Lexica can be used to teach German to English-speaking 
students and with another set of data files it can be used by French students learning 
Spanish.  

Textbook/Workbook

The user interacts with the Lexica Textbook/Workbook (Textbook for short) through a 
standard Macintosh Window.  The Textbook data is divided into ten Chapters, and each 
Chapter is further subdivided into Sections.  There are currently twelve types of Sections:

1) Contents Sections 7) General Picture Sections
2) General Text Sections 8) Picture Exercise Sections
3) Reading Sections 9) Locator Sections
4) Exercise Sections 10) Word Search Sections
5) Vocabulary Sections 11) Crossword Sections
6) Scrambled Sentence Sections 12) Index Sections.

And new Section types can easily be added.  (A Video Section will soon be available).

The Textbook contains one Index Section, ten Contents Sections (one for each Chapter), and 
up to 255 of the other types of Sections per Chapter.

• Contents Sections list the type, title, and modification date of each Section in a Chapter.
• General Text Sections contain static text, such as grammar rules or cultural information.
• Reading Sections contain a foreign language reading passage along with the translations 

and audio recordings of each foreign language sentence.
• Exercise Sections contain general fill-in-the-blank exercises, called Fillins for short.  For 

example, the user would correctly complete this sample Fillin:

by typing the word  "am"  into the space provided.
• Vocabulary Sections contain lists of foreign words and their translations.  These lists can be

displayed either as static text or as Fillin exercises.
• General Picture Sections contain a static picture.
• Picture Exercise Sections contain a static picture and Fillin questions about the picture.
• Locator Sections contain a picture and questions that are answered by locating specific 

parts of the picture.
• Word Search Sections contain words hidden in an array of letters as well as clues 

identifying each hidden word.  The student uses the clues to find the hidden words.



• Crossword Sections contain a crossword puzzle.
• The Index Section contains an alphabetically sorted list of references to topics covered in 

the Textbook.

By using a special editing mode it is possible to add, delete, and modify any Section in the 
Textbook.  Sections can also be created with a standard word processing package (such as 
Microsoft Word) and then incorporated into the Textbook.

Foreign Language Dictionary

The Dictionary can be used to find the translation and hear the pronunciation of up to 
400,000 words or phrases.  It is actually two separate dictionaries: a foreign to native 
language dictionary and a native to foreign language dictionary. It is possible to:

• hear a dictionary word pronounced
• switch dictionaries with the click of a mouse
• browse through a dictionary.

And by using the special editing mode it is also possible to:
• add and delete words and sounds from a dictionary
• automatically load a large number of words into a dictionary by reading them from a 

standard text file.

Flash Cards

The Flash Cards are an automated self-testing tool.  The user indicates the types of 
questions to be reviewed and the Chapters the questions should be drawn from.  Lexica then
creates as many "flash cards" as it can that match the user's specifications and displays 
them one at a time.  The user is allowed to check his/her response, to see the correct 
answer, and to remove cards from the question pool.  Seven types of questions are currently
supported:

1)  Foreign to native vocabulary questions
2)  Native to foreign vocabulary questions
3)  General fill-in-the-blank exercises
4)  Foreign to native sentence translation exercises
5)  Native to foreign sentence translation exercises
6)  Dictation exercises
7)  Audio foreign to native sentence translation exercises.

Help

In addition to the three main tools already mentioned, Lexica has an on-line Help tool that is 
designed to make learning how to use Lexica as painless as possible.  The Help tool contains
explanations of every part of every Window that Lexica can display, as well as of every 
command Lexica responds to.  The user can access these explanations at any time either by 
browsing through the list of available Help topics or by using a special "Help Mode".  In the 
Help Mode, simply issuing the confusing command or clicking the mouse on the part of the 
screen that needs explaining will automatically access the appropriate Help information.  
Advanced users can also use the special editing mode to modify the Help data.



Getting To Know Lexica
Lexica has four main Windows: 

• the Textbook/Workbook Window (titled Lexica)
• the Flash Cards Window
• the Dictionary Window
• the Help Window 

This segment contains annotated pictures of each of these Windows and a short description 
of how they work.

The Textbook/Workbook Window

† this part is not always visible.

• The Header Pane contains the Section Pop-Up Menu.  It may contain some Header Pane 
Controls depending on what type of Section is being displayed in the Upper and Lower 
Panes.

• The Section Pop-Up Menu  shows the title and type of the current Section.  It can also be 
used to change Sections.

• The Upper Pane displays the contents of the current Lexica Section.

• The Upper/Lower Pane Divider Bar is only visible when Lexica is open to a Section type that
has a Lower Pane.  Clicking and dragging the mouse on the Upper/Lower Pane Divider Bar 
shows more or less of the two Panes.

• The Lower Pane is an auxiliary pane that certain types of Section use.

• The Chapter Button Array shows which Chapter the current Section is in.  It can also be 
used to change Chapters.

• Clicking in the upper-left (lower-right) part of the Section Pager Button opens the next 
(previous) Section.



The Flash Cards Window

After choosing the types of Flash Card questions to be asked and which Chapters they 
should be drawn from, this Flash Cards Window will appear.

• The Flash Card Pane displays the current Flash Card question.

• The Dictate Button is enabled if the current Flash Card question has a sound associated 
with it.  Clicking this Button causes the sound to be played.

• The Show Button causes the Flash Card Pane to show the Author Response to the current 
question.  When an Author Response is showing, this Button turns into a Hide Button.

• The Next Button causes the next question to be loaded into the Flash Card Pane.  If there 
are no more questions then this becomes the Done Button, which has the same effect as 
the Cancel Button.

• The Previous Button causes the previous question to be re-loaded into the Flash Card Pane.

• The Cancel Button ends the current Flash Cards session.  It has the same effect as clicking 
the mouse in the close box.

• If the Remove Control is set when either the Next or Previous Button is pressed then the 
current question will be removed from the pool of possible Flash Card questions.  All 
removed questions can be reinstated by clicking the "Use All Cards" Control in the Flash 
Card's Set-up Dialog Window.



The Dictionary Window

• The default Look up/List Button is titled "Look up" or "List" depending upon the status of 
the Dictionary.  The Look up Button causes the Dictionary to search its contents for the 
text in the Input Pane.  The List Button causes the Dictionary to display its list of words.

• The Input Pane contains text that the Dictionary is about to, or already has looked up.

• The Pronounce Button is enabled when the Dictionary retrieves an entry with associated 
sound data.  Clicking this Button causes the pronunciation to be played.

• The Dictionary is actually two translation dictionaries, and the Switch Dictionaries Button 
switches between them.  The Dictionary Window's title indicates the current dictionary 
(e.g., "German to English Dictionary" or "English to German Dictionary").

• The Add Word Button causes the Dictionary to try to add the word in Input Pane to its 
contents.

• The Delete Word Button causes the Dictionary to try to delete the word in the Input Pane.

• The AutoLoad Button causes the Dictionary to load a specially formatted file of words and 
translations.

• The Output Pane contains either the translation of the looked-up word or the list of words 
the Dictionary contains.

• The Infinite Scroll is just a standard Macintosh Scroll without the "thumb".  It aids in 
scanning the Dictionary's word list.



The Help Window

• The Help/Topics Pane contains either helpful information (a topic) or a list of Help topic 
titles. 

• The default Help/Topics Button is labeled "Help" or "Topics" depending on the contents of 
the Help/Topics Pane.  It toggles the contents of the Help/Topics Pane between a Help topic 
and the list of all available Help topic titles.

• The Cancel Button closes the Help Window.

• The Next Button and Previous Button are enabled whenever the Help/Topics Pane contains 
a Help topic.  The Next (Previous) Button displays the next (previous) topic in its list.



About Lexica Demo
As was already mentioned, Lexica is really two distinct pieces: the application and the 
foreign language data that this application manipulates.  The application part of Lexica 
Demo is close to its envisioned form (aside from testing and future enhancements).  The 
foreign language data, on the other hand, is just a simple demonstration (written by 
programmers, not foreign language experts).  

Lexica Demo attempts to realistically show how Lexica can be used.  However, due to time 
and space limitations some imagination is still required to see its full potential.

Chapter 0 in Lexica Demo contains some demonstrative rather than substantive German 
lessons.  The rest of the Chapters in Lexica Demo are empty.  The Dictionaries have only a 
few hundred words, and sounds have only been added in a few places.  The reasons for this 
brevity are two-fold: 1) our foreign language skills are not good enough to write real foreign 
language lessons and 2) we want to keep the Demo at a reasonable size.

Notes and Disclaimers:

1) The Lexica Demo has a built-in expiration mechanism and will not run after a pre-
programmed date.

2) Lexica Demo has not yet been fully tested on all Macintoshes and is not claimed to be 
bug-free.

3) We recommended that Lexica Demo be run on a Macintosh with a color or gray scale 
monitor and a hard disk.

4) The Lexica Demo disk has been checked for viruses with Disinfectant 2.5.1.

5) Any suggestions or criticisms are welcome.

Mail: HeadFirst Designs
17 Azalea Dr.
Mill Valley, CA 94941

Phone: (415) 388-HEAD
(415) 388-4323



Lexica Demo Guided Tour
This segment is a "guided tour" of Lexica Demo (illustrated with black and white screen 
shots).  The tour is quite brief so feel free to take some detours along the way.  The basic 
plan is to launch Lexica Demo and see the following Textbook Sections in User Mode:

1) The Front Cover Picture Section
2) Chapter 0 Contents Section
3) Chapter 0 Reading Section
4) Chapter 0 Vocabulary Section
5) Chapter 0 Scrambled Sentence Section
6) Chapter 0 Locator Section
7) Chapter 0 Word Search Section
8) Chapter 0 Crossword Section

Then we will look at the following Lexica Utilities:
9) Flash Cards
10) Dictionary
11) Help

Finally we will show:
12) How to Create a Crossword Section Using Author Mode
13) A Commercial.

• For definitions of the terms used in this tour guide please refer to the Getting to Know 
Lexica  and Details parts of this manual.

To begin, copy the application Lexica Demo and the folder Lexica Data from the floppy 
disk to your hard disk (you can run off the floppy, but it is slower) and launch Lexica Demo.



1) The Front Cover Picture Section

When Lexica Demo, starts it opens the Textbook/Workbook to a Picture Section entitled "The 
Front Cover", as illustrated below:

(Note:  this is a black and white reproduction of a color picture, as are most of the pictures in
this document.)

• Use the Chapter Button Array to open the Chapter 0 Contents Section.  The Chapter Button
Array is located at the bottom of the Lexica Window and looks like this:

 
Clicking the mouse in the box with the "0" in it will open the Chapter 0 Contents Section.



2) Chapter 0 Contents Section

The Chapter 0 Contents Section looks like this:

∆ A Contents Section displays a list of the Sections contained in its Chapter.  Each Section's 
type is indicated by its type icon.  (Refer to the Details section 2 for a icon-type list.)

• Open the Reading Section titled "Story of a Food Critic" by double clicking on its type icon (
).



3) Chapter 0 Reading Section

The Chapter 0 Reading Section looks like this:

∆ A Reading Section contains a foreign language passage in the Upper Pane and its 
translation in the Lower Pane.  It also contains a digital recording of each foreign language 
sentence.

NOTE: the lower pane does not have to contain translations of the sentences in the upper 
pane, as illustrated in the Section "Story of a Food Critic 2".

• Try this:
a) Experiment by clicking the mouse on words in the two Panes.  Notice how the 

translation of the sentence you click on is scrolled to the top of the other Pane.
b) Use the Buttons in the Header Pane to hear Lexica "read" sentences in this Section.  

Notice that the Talk Button reads just one sentence, and the Talk-Talk Button reads to 
the end of the Section.  (You can stop the reading by clicking the mouse or typing a 
key.)

c) Click and drag the Upper/Lower Pane Divider Bar to show and hide the Lower Pane.  
Notice how the cursor changes shape when it is on the Divider Bar.

• Open the Chapter 0 Vocabulary Section by selecting "Essen Wortschatz" from the Section 
Pop-Up Menu in the Header Pane.  The Pop-Up Menu looks like this:

Click and hold the mouse on the shadowed rectangle to see the Menu items.



4) Chapter 0 Vocabulary Section

The Chapter 0 Vocabulary Section looks like this:

∆ A Vocabulary Section contains two columns of words; the left column contains foreign 
words and the right contains their translations.

• Try this:
a) Experiment with the Switch Button in the Header Pane.  Notice how it replaces the 

words or their translations with Fillin Boxes.
b) Practice typing and Peeking (SHIFT-mouse down) in the Fillin Boxes.  Notice how the 

cursor changes into a when the SHIFT key is down and it is positioned over a Fillin Box.
c) Try the "Check Answers ⌘=", "Unselect Answers ⌘-", and "Clear Answers" commands 

under the Utilities Menu (when Fillin Boxes are visible).  Note: incorrect answers are 
indicated by outlining the Fillin Box with a moving dashed pattern.

Note: typing RETURN when the cursor is in a Fillin Box causes Lexica to compare the Student
Response with the Author Response and emit an appropriate beep depending on the result.
(This feature can be disabled by selecting the AutoCheck option from the Utilities Menu.)

Note: typing TAB selects the next Fillin and SHIFT-TAB selects the previous Fillin.

• Open the next Section by clicking the upper left arrow in the Section Pager Button.  The 
Section Pager Button is located near the bottom right corner of the Lexica Window and 
looks like this: .



5) Chapter 0 Scrambled Sentence Section

The Chapter 0 Scrambled Sentence Section looks like this:

∆ A Scrambled Sentence Section contains sentences that have been broken into phrases and
scrambled (arranged in a random order ).  Phrases are delimited by "/" characters.  They 
are re-arranged by clicking and dragging them with the mouse.

• Try this:
a) Re-arrange the sentences by clicking and dragging the phrases.  Notice that the "/" 

characters invert when you drag a phrase over them.  This indicates where the phrase
will be placed if you release the mouse.

b) Peek at the correct answers in the usual way (i.e., hold down the SHIFT key and click 
on the thing you want to see the answer for).

c) Try the "Check Answers ⌘=", "Unselect Answers ⌘-", and "Scramble Sentences" 
commands under the Utilities Menu.

• Open the Chapter 0 Locator Section by choosing "die Küche"  (or "die Küche [B&W]") from 
the Section Pop-Up Menu.



6) Chapter 0 Locator Section

The Chapter 0 Locator Section looks like this:

∆ A Locator Section contains a picture with Holes in it as well as questions about the picture. 
The questions are completed by clicking and dragging numbered Flags to their correct 
Holes.

• Try this:
a) Click the mouse down on a question, and drag the Flag that appears to a Hole.  Notice 

that a Hole inverts when the Flag is in it.
b) Peek at the correct answers from both the Upper and Lower Panes.  As usual, hold 

down the SHIFT key and click the mouse on the thing you want to see.
c) Try the "Check Answers ⌘=", "Unselect Answers ⌘-", and "Clear Answers" commands 

under the Utilities Menu.

Note: you can also drag Flags between Holes, and you can replace a Hole's Flag by putting a
new Flag in it.  (The old Flag will automatically be removed.)

• Open the "Food Search" Word Search Section by using the Section Pop-Up Menu.



7) Chapter 0 Word Search Section

The Chapter 0 Word Search Section looks like this:

∆ A Word Search Section contains a list of words hidden in an array of letters and a list of 
clues for each of the hidden words.  Hidden words are selected by clicking and dragging 
the mouse over them.

• Try this:
a) Click and drag the mouse in the Upper Pane.  Notice how a flashing outline is drawn 

around the letters you drag over.
c) Peek at the correct answers from the Lower Pane (hold down the SHIFT key and click 

the mouse on a clue).  Notice the animated outline that appears in the Upper Pane.
d) The "Clear Answers" commands under the Utilities Menu will erase all the words that 

have been outlined.

Note: space characters in the Upper Pane are represented by "-"s.

Note: the Utilities Menu's "Check Answers ⌘=" and "Unselect Answers ⌘-" items are 
disabled in Word Search Sections.

Note: Lexica makes a "good" or "bad" beep after each click and drag unless the "AutoCheck 
Answers" feature has been turned off.  (Use the "AutoCheck Answers" item under the 
Utilities Menu to turn this feature off and on.)

• Open the "Food Puzzle" Crossword Section by using the Section Pager Button.



8) Chapter 0 Crossword Section

The Chapter 0 Crossword Section looks like this:

∆ A Crossword Section contains an electronic crossword puzzle.

• Try this:
a) Experiment by clicking in the Upper and Lower Panes.  Notice how the corresponding 

Fillin and crossword are always selected together.
b) Try typing into the Fillin Boxes in the Lower Pane.  Notice that the typing appears in 

both the Upper and Lower Panes.
c) Peek at the correct answers in both the Upper and Lower Panes (hold the SHIFT key 

down and click on the thing you want to see, as usual).
d) Try the "Check Answers ⌘=", "Unselect Answers ⌘-", and "Clear Answers" commands 

under the Utilities Menu.

• We have skipped a few Section types in this tour, but they are generally variations of the 
ones you have seen.  Now let's look at Lexica's Utility Windows.



9) Flash Cards

Select the "Flash Cards..." item from under the Utilities Menu.  Choose the types of questions
you want to be asked when the Set-up Dialog appears (see The Flash Cards in Student Mode 
for graphic).   After Lexica has assembled your flash cards the Flash Card Window will 
appear; it should look something like this:

• Try this:
a) Experiment with the Buttons.
b) Try Peeking and using the "Check Answers ⌘=", "Unselect Answers ⌘-", and "Clear 

Answers" commands under the Utilities Menu.

Note: the Remove Button removes the current question from the Flash Card pool.  This 
should be used if you don't want to be asked the current question anymore.  The removed 
cards can be re-instated by using the Use All Cards Button in the Set-up Dialog.



10) Dictionary

• Invoke the Lexica Dictionary by choosing the "Dictionary... ⌘L" command from the Utilities 
Menu.

The Dictionary Window should look something like this:

• Try this:
a) Experiment with the Look Up/List Button and the Switch Dictionaries Button. (The 

Pronounce Button will not activate because no sounds have been added to the Lexica 
Demo Dictionaries, and the other Buttons are only activated in Author Mode.)  Notice 
how the default Button's title changes depending on what is being displayed in the 
Output Pane.

b) Try clicking and double clicking in the Output Pane when a Dictionary word list is being
displayed.  Notice how a single click loads the word you clicked on into the Input Pane 
and how double clicking displays the translation for the word.

Note: when the Dictionary is invoked the currently highlighted text in the active Window is 
automatically loaded into the Input Pane, and the Dictionary attempts to look it up.

Note: only a few hundred words have been added to the Lexica Dictionary to conserve disk 
space; however, each dictionary is capable of holding over 400,000 entries.  (Sounds have 
only been added to the words Nachtish and Wein.)



11) Help

• Invoke the Lexica Help Facility by choosing the "Help... ⌘H" command from the Utilities 
Menu.

The Help Window should look something like this:

• Try this:
a) Experiment with the Help/Topics Button.  Notice how this Button's title changes 

depending on what is being displayed in the Output Pane.
b) Try clicking and double clicking in the Output Pane when the Help topics list is being 

displayed.  Notice how a double click causes the Help information for the selected 
topic to be displayed.

c) Try clicking the Next and Previous Buttons when an individual Help topic is being 
displayed.

• Try using the Help Mode to find out about a part of a Lexica Window or a Lexica 
command:

1) Enter Help Mode by typing "⌘?" (i.e., hold down the ⌘ key and type a "?").  The cursor
will turn into a "?" to indicate Lexica is now in Help Mode.

2) Click the "?" cursor on a part of a Lexica Window that you want to see the Help 
information for (the Chapter Button Array, for instance), or choose a command from a 
Menu (Author Mode from the Mode Menu, for instance).  In either case the Help 
Window will appear, displaying information about the part of the Window or the 
command that you indicated.

Note: you can exit Help Mode without requesting any Help by typing any key.



12) How to Create a Crossword Section Using Author Mode

Now let's look at how Lexica operates in Author Mode by creating a new Crossword Section
in Chapter 1.  (You may want to read some of the Details section of this manual first.)

• Try this:
1) Enter Author Mode by choosing the "Author Mode" item from the Modes Menu.
2) Open the Textbook/Workbook (the Window titled "Lexica") to the Chapter 1 Contents 

Section.  (Clicking in the "1" box in the Chapter Button Array is the easiest way.)
3) Select the "Add New Section..." command from the File Menu.  The following Dialog 

Box will appear:

4) Choose the "Crossword" Section type, and give your new Section a name.



5) Open your new Section by double clicking on its icon.  (Note: in Author Mode you can't
open a Section by double clicking on its title because Lexica thinks you are trying to 
edit the title.)  In Author Mode the new Crossword Section will look like this:

6) Create some questions for your crossword puzzle.  For example:
i) Click in the Lower Pane, and type the following three lines:

ein bißchen mehr als nichts : eins 
Wievel Handë haben sie? : zwei
Ein und zwei macht : drei

ii) Select a line and use the "New Cell ⌘N" command from the Edit Menu to turn it 
into a Cell.  Do this for the other two lines too.

iii) Select the word "eins" and use the "New Fillin ⌘N" command from the Edit Menu 
to turn it into a Fillin.  Do this for the words "zwei" and "drei" also.

7) In the Upper Pane create the crossword puzzle that goes with these questions.  Click 
the mouse in a box in the Upper Pane and type the answers to the questions you 
made in the Lower Pane. (Notice that the cursor shows the typing direction, and that 
you can change the typing direction by clicking the cursor on the currently highlighted
box.)  When you are finished, the Upper Pane should look something like this:

Congratulations!  You have just created a new Lexica Section.  Return to Student Mode and 
check it out.

13) A Commercial

• Choose the "About Lexica..." command from under the Apple Menu.



Details

1) Student Mode & Author Mode

Lexica can operate in two editing modes: Student Mode and Author Mode.  Most people will 
not need to use Lexica's Author Mode.  Visually, the differences between Student Mode and 
Author Mode are small.  There are additional Menus and Menu items in Author Mode, and 
most Sections look slightly different.  The most important difference is that in Author Mode 
all of Textbook's data can be modified;  in Student Mode this data is protected.

This manual will first describe how Lexica works in Student Mode and then show how 
changes, additions, and deletions to the Lexica's data can be made in Author Mode.

The Mode Menu shows which editing Mode Lexica is currently using and allows the user to 
change Modes.

2) Textbook/Workbook In Student Mode

The Lexica Textbook/Workbook currently supports 12 different types of Sections.  Each 
Section type is identified with a small icon.  The following is a list of the Section types and 
their associated icons:

The Lexica Textbook contains a single Index Section.  Each Chapter begins with a Contents 
Section, and there can be up to 255 additional Sections of any type other than Contents or 
Index in each Chapter.  

The segments that follow will describe how each of these Section types works in Student 
Mode.

2a) Contents Section in Student Mode

Contents Sections look and work like Macintosh Finder™ Windows using a non-icon view 
mode.  Contents Sections display a list of the Sections contained in a particular Chapter.  
This list also contains the Section's type icon and its modification date.

Clicking the mouse in a Contents Section Pane selects (highlights) the Section on the clicked 
line.  Once a Section has been selected it can be opened with the File Menu's "Open ⌘O" 
command.  A Section can also be opened by double clicking on its line.



2b) General Text Sections in Student Mode

General Text Sections display static text, such as grammar lessons.  And when Lexica is open
to a General Text Section the Header Pane contains one control, a Tear-Off Button, . The 
Tear-Off Button is used to "tear off" a copy of the current Section and put it in a new Window 
for quick reference.

2c) Reading Sections in Student Mode

Reading Sections contain passages for reading comprehension and pronunciation practice.  
When Lexica is displaying a Reading Section both the Upper and Lower Panes are visible, 
and the Header Pane contains two controls: a Talk Button, , and a Talk-Talk Button, .

The Upper Pane contains a number of foreign language sentences; the Lower Pane contains 
their translations.  Clicking the mouse on a sentence in one Pane causes its translation to be 
scrolled to the top of the other Pane.  In addition, each foreign language sentence usually 
has an audio recording associated with it.  And these recordings can be played with the 
Buttons in the Header Pane.  The Talk Button plays the currently highlighted sentence, while 
the Talk-Talk Button plays the currently highlighted sentence and then proceeds to play each 
of the following sentences.  Clicking the mouse or typing a key stops a sound from playing.

2d) Exercise Sections in Student Mode

Exercise Sections contain a list of fill-in-the-blank (Fillin) exercises.  The student interacts 
with these exercises by typing responses into Fillin Boxes embedded in each exercise.  For 
example: the following exercise:

would be completed by typing the word "am" into the Fillin Box.

Each exercise in an Exercise Section can have an audio clue associated with it.  If an 
exercise does have a sound it can be played with the Talk Button in the Header Pane once 
the exercise is selected.

Typing a TAB selects the next Fillin Box; typing a SHIFT-TAB selects the previous Fillin Box.  
Typing a RETURN checks the Student Response in the currently selected Fillin and issues an 
appropriate beep.  (Note: whenever Lexica beeps, the Apple Menu's "Why Beep?" command 
can be used to find the reason.)

The Utility Menu's "Check Answers ⌘=" command will cause Lexica to compare the Student 
Response in each Fillin with the correct answer.  Incorrect responses are indicated by 
animated Fillin Boxes.  The "Unselect Answers ⌘-" command under the Utility Menu will 
remove this animation.  The Utility Menu's "Clear Answers" command will cause Lexica to 
erase the Student Responses from all the Fillins in the Section.

The student can "Peek" at the correct Fillin answer by holding down the SHIFT key and 
clicking the mouse in the Fillin Box.



2e) Vocabulary Sections in Student Mode

Vocabulary Sections contain two columns of words and/or phrases: one column is for foreign 
words and the other is for their translations.  When Lexica is open to a Vocabulary Section 
the Header Pane contains two controls: a Talk Button and a Switch Button.  The Talk Button is
used to play any sound associated with a particular word, just as in other Sections.  The 
Switch Button controls whether the foreign words or their translations or both are visible.  
(The Switch Button looks like: , , or  depending on what is visible).  Words are 
hidden by replacing them with Fillin Boxes which work just like they do in other Sections.

2f) Scrambled Sentence Sections in Student Mode

Scrambled Sentence Sections contain sentences that have been broken into short phrases 
by "/"s and scrambled (i.e., put in some random order).  The student must rearrange these 
phrases by clicking and dragging them with the mouse.  Each sentence can have an audio 
clue that can be played with the Talk Button in the Header Pane, just as in other Sections.  
The student can also Peek at the correct word order of a sentence by holding down the 
SHIFT key and clicking the mouse on it.  (Note: the "Clear Exercises" command in the 
Utilities Menu becomes a "Scramble Sentences" command when a Scramble Section is being
displayed.)

2g) Picture Sections in Student Mode

A Picture Section contains a static picture.

2h) Picture Exercise Sections in Student Mode

A Picture Exercise Section is really just a Picture Section in the Upper Pane and an Exercise 
Section in the Lower Pane.  The Lower Pane exercises usually contain questions about the 
picture in the Upper Pane.

2i) Locator Sections in Student Mode

A Locator Section contains a picture with special Holes in it in the Upper Pane and questions 
about this picture in the Lower Pane.  These questions are answered by identifying the 
correct part of the picture.  An identification is made by clicking on a question and dragging 
the numbered Flag that appears to the appropriate Hole in the picture.  (The Hole will 
highlight when the Flag gets close enough.)  For example, suppose the Upper Pane contains 
a picture of our solar system and the first question in the Lower Pane is "Where is Earth?"  
The student would correctly answer this question by clicking on it and dragging the Flag, 
, to the third planet from the sun.

Lexica will signal correct and incorrect identifications with appropriate beeps (just as in other
Sections).  Flags can also be dragged from Hole to Hole or removed from the Upper Pane by 
releasing them outside of any Hole.

The student can Peek at the correct answer by holding down the SHIFT key and clicking the 
mouse on either a Hole in the Upper Pane or a question in the Lower Pane.  The "Check 
Answers ⌘=", "Unselect Answers ⌘-", and "Clear Answers" commands under the Utilities 
Menu work in the usual way.



2j) Word Search Sections in Student Mode

Word Search Sections contain words hidden in an array of letters in the Upper Pane and 
clues identifying the hidden words in the Lower Pane.  (Space characters in the letter array 
are represented by "-"s.)  The student locates a hidden word by clicking and dragging the 
mouse over that word in the letter array.  Correctly identified words are circled and their 
clues are highlighted in gray.  An appropriate beep is emitted when a correct or incorrect 
identification is made.  The "Clear Exercises" command under the Utilities Menu erases any 
circles that have been drawn around words in the Upper Pane.  If the clues in the Lower Pane
have sounds associated with them, then they can be played with the Talk Button in the 
Header Pane.  The student can also Peek by holding down the SHIFT key and clicking the 
mouse on a clue in the Lower Pane.

2k) Crossword Sections in Student Mode

Crossword Sections contain a crossword puzzle in the Upper Pane and the questions for it in 
the form of an Exercise Section in the Lower Pane.  Selecting a Fillin in the Lower Pane 
highlights its corresponding range in the crossword puzzle and vice versa.  Typed characters 
appear in both the current Fillin Box in the Lower Pane and in the corresponding crossword 
boxes in the Upper Pane.  If two different letters in two different Fillins intersect in the 
crossword puzzle then a "?" is displayed in that crossword box.  The student can Peek at the 
correct answers in the usual way in both the Upper and Lower Panes.

2l) Index Section in Student Mode

The Index Section contains an alphabetically sorted list of references along with the 
Chapters and Sections that they refer to.  Clicking the mouse on a reference selects it and 
enables the File Menu's "Open Selected Section ⌘O" item.  Double clicking a reference 
causes Lexica to open the Section that it refers to.  Typing a letter automatically selects the 
first reference that begins with that letter.



3) The Flash Cards in Student Mode

The Lexica Flash Card Utility is the electronic equivalent of a stack of paper flash cards.  It is 
accessed through the "Flash Cards..." item in the Utilities Menu.  When this Utility is invoked 
the following Set-up Dialog appears:

This Dialog Window allows the student to choose the types of questions to be used in the 
Flash Cards and the Chapters from which they are to be drawn.

The "Use All Cards" Control re-instates questions that were discarded with the "Remove" 
Control in the Flash Cards Window.

Once this Set-up Dialog is complete the Flash Cards Window appears (see graphic in the 
Details section 3), displaying the first of a randomly ordered list of questions.  Every Flash 
Card question contains brief instructions and one or more Fillin Boxes to receive the 
student's response.



4) The Dictionary in Student Mode

The Lexica Dictionary Utility is actually two translation dictionaries: a foreign to native 
language dictionary and a native to foreign language dictionary.  It is accessed through the 
"Dictionary... ⌘L" command under the Utilities Menu.  Whenever the Dictionary is invoked it 
tries to look up any text selected in the currently active Window, and it puts up the 
Dictionary Window (see graphic in Getting to Know Lexica) to display the results of that 
search.

If a search is successful the Dictionary will display the translation of the looked up word in 
the Output Pane, its status will be "Found", and if the entry includes a sound the Pronounce 
Button will be enabled.

If a search is unsuccessful the Dictionary will display its list of alphabetically similar words in 
the Output Pane, and its status will be "Not Found".  Clicking on a word in the Output Pane's 
word list loads it into the Input Pane.  Double clicking on a word looks it up.  Words can also 
be loaded into the Input Pane from the keyboard.

Immediately to the right of the Pronounce Button is the Dictionary Switch Button.  This 
Button and its Utility's Menu equivalent, "Switch Dictionaries", cause Lexica to swap in its 
other dictionary.  For example if the "German to English" dictionary was active before the 
Switch Command, the "English to German" dictionary will be active after.  The Switch Button 
as well as the Dictionary Window's title always indicate which dictionary is active.

5) The Help Utility in Student Mode

The Lexica Help Utility is Lexica's on-line users manual.  It is invoked either through the 
"Help ⌘H" item in the Utility Menu or automatically when in the Help Mode.

When Help is requested the Help Window appears (see graphic in Getting to Know Lexica).  
Its Help Pane contains either a list of available Help topic titles or detailed information about 
a selected topic.  The default Button (Help/Topics) toggles between these two displays.  
Topics are selected by clicking on the appropriate line in the topics title list.  Double clicking 
on a line directly displays any information about that topic.  When Help information is being 
displayed the Next and Previous Buttons can be used to display the next or previous Help 
topic's information.

• Important •

Help Mode is a short cut to Help information on a specific Menu item or graphical object.   
By typing ⌘?, Help Mode is entered, and the cursor becomes a "?".  Once in Help Mode 
clicking the mouse on part of a Lexica Window or issuing a Menu command is interpreted as 
a request for Help on that topic.  Typing any key (except ⌘-key combinations) in Help Mode 
returns Lexica to its previous Mode.



6) The Textbook/Workbook in Author Mode

In Author Mode the Lexica Textbook/Workbook looks very similar to the Textbook in Student 
Mode.  The Menu Bar gains two entries, Edit and Style, and the File and Utilities Menus gain 
commands, but most things appear relatively unchanged.  This is deceiving.  All changes 
made to the Textbook and its Utilities while in Author Mode are interpreted as an author's 
editing of the form and contents of the Textbook.  Author Mode allows an author to add, 
delete, and modify Sections, add and delete Index entries, and edit Help and the Dictionary.  
(A special word of caution: the Undo command is not currently implemented.)

Before examining each Section type in Author Mode, the concepts of Cells and Fillins must 
be introduced.

• A Cell is nothing more than a range of characters in a text based Section.  Cells obey the 
following rules:

1) Cells cannot intersect each other
2) A Cell can only be deleted all at once.  Trying to delete only the first or last 

characters of a Cell will generate a complaint beep.  Deleting only characters in the 
interior of a Cell or deleting an entire Cell is allowed. 

Cells are created by selecting a range of characters that does not intersect another Cell and 
then invoking the Edit Menu's "New Cell ⌘N" command.

In Author Mode, Cells are delimited by "[" and "]" characters.  (These delimiting characters 
are hidden in Student Mode.)

Most Cells can have sounds associated with them.  A sound can be added to or removed 
from the active Cell (i.e.,  the Cell containing the selection point) by using the "Cut Sound", 
"Copy Sound", or "Paste Sound" items under the Edit Menu.

• A Fillin is also a range of characters in a text based Section, but this range can contain 
two separate sets of characters.  One set is called the Author Response and the other is 
called the Student Response.  Fillins obey the following rules:

1) Fillins only exist inside of Cells
2) Fillins cannot intersect each other
3) A Fillin can only be deleted all at once
4) Fillins cannot contain more than a fixed number of characters. (The exact number 

depends on the type of Section they are being used in.)

(Note: the same command is used to create Cells and Fillins.  It automatically changes from 
"New Fillin" to "New Cell" depending on whether or not the selection range is inside a Cell.)

In Author Mode the Author Response is drawn in red, underlined, 12 point 
Courier font  and delimited by "<" and ">" characters.  In Student Mode the Author 
Responses are replaced with Student Responses (except when the student is Peeking),  and 
the delimiters are replaced by Fillin Boxes.  Student Responses are drawn in blue, 12 
point, Courier font.

Fillins can have multiple Author Responses.  Multiple Author Responses are separated by a 
"|" character.



6a) Contents Sections in Author Mode

Sections can be added, deleted, and renamed from a Contents Section in Author Mode. 

Selecting the "Add Section..." command from the File Menu causes the following Dialog to 
appear:

Once a Section type and title are chosen Lexica creates the requested Section and places it 
immediately after the Contents Section's currently selected Section.  And, as the title 
implies, the File Menu's "Delete Selected Section" command causes Lexica to remove the 
currently selected Section from the Textbook.  Sections can also be renamed by selecting 
their titles and typing a new name (just as you would rename a Macintosh file).  Double 
clicking a Section's icon will still open the Textbook to that Section.

6b) General Text Sections in Author Mode

In Author Mode the text in General Text Sections can be edited using standard Macintosh 
editing techniques.  Neither Cells nor Fillins are used in General Text Sections.

6c) Reading Sections in Author Mode

In Author Mode the text in Reading Sections can be edited, Cells can be added and deleted, 
and sounds can be added to and deleted from Cells in the Upper Pane.

The Upper and Lower Panes of a Reading Sections usually contain Cells filled with sentences.
Lexica expects each Cell in the Upper Pane to have a corresponding Cell in the Lower Pane.  
If the Cell counts in the Upper and Lower Pane do not match, Lexica will complain.  Lexica 
also expects each Cell in the Upper Pane to have a sound associated with it. (Again, Lexica 
will complain if this is not the case.)  An author can add Cells and sounds using the Edit 
commands described in segment 6, The Textbook/Workbook in Author Mode.



6d) Exercise Sections in Author Mode

In Author Mode the text in Exercise Sections can be edited, Cells and Fillins can be added 
and deleted, and sounds can be added to and deleted from Cells.

6e) Vocabulary Sections in Author Mode

In Author Mode the text in Vocabulary Sections can be edited, Cells and Fillins can be added 
and deleted, and sounds can be added to and deleted from Cells.

Lexica expects each Cell in the Vocabulary Section to have exactly two Fillins. (If it doesn't 
then Lexica will complain when the Section is opened.)  The first Fillin should contain a 
foreign word or phrase and the second should contain its translation.

6f) Scramble Sections in Author Mode

In Author Mode scrambled sentences can be added, deleted, and modified.  Sounds can also 
be added and deleted.

A scrambled sentence begins as a sentence within a Cell.  It is then broken into phrases by 
inserting "/" characters.  These phrases are automatically scrambled when Lexica leaves 
Author Mode and unscrambled when Lexica re-enters Author Mode.  (Lexica will also 
automatically add "/"s to the beginnings and ends of all scramble sentences if the author 
forgets to.)

6g) Picture Sections in Author Mode

In Author Mode pictures can be cut, copied, and pasted in Picture Sections.

In Author Mode the picture in a Picture Section has a grey border around it.  Any picture 
created with a standard drawing application and copied into the Clipboard can be pasted 
into a Picture Section using the Edit Menu's "Paste ⌘V" command.  Conversely,  pictures 
already in a Picture Section can be cut or copied to the Clipboard with similar Edit Menu 
commands.

6h) Picture Exercise Section in Author Mode

Picture Exercise Sections are really just a Picture Section in the Upper Pane and an Exercise 
Section in the Lower Pane; therefore, they behave just as these two Sections do.  When 
using the Edit Menu's commands (cut, copy, and paste) be sure that the correct Pane is 
activated.  Clicking in a Pane activates it and deactivates the other Pane.

6i) Locator Sections in Author Mode

In Author Mode the user can cut, copy, and paste pictures in the Upper Pane, change the 
location of Holes, and create and delete questions (and their associated Holes).

In Author Mode the numbered Flags are always in their correct Holes; clicking and dragging 
a Flag (or its Hole) moves both the Flag and its Hole.  

When an author creates a new Cell in the Lower Pane a new Hole-Flag pair is automatically 
added to the Upper Pane. (They are placed in the center of the picture.)  Conversely, when a
Cell is deleted from the Lower Pane its Hole-Flag pair is removed from the Upper Pane.



6j) Word Search Sections in Author Mode

In Author Mode the text in the Upper and Lower Panes can be edited, words can be added to 
and deleted from the Upper Pane, and their clues can be added to and deleted from the 
Lower Pane.  Sounds can also be added to and removed from the clues in the Lower Pane. 

In Author Mode Word the Upper Pane contain a 25 x 40 Grid.  Letters can be added to the 
Grid by typing or pasting.  (Space characters are replaced by "-"s.)  The highlighted Gird Box
indicates where the next typed character will appear.  Whenever the cursor is in the Grid 
Pane it indicates the direction in which this highlighted Box will move.  For example, the 
following picture shows what part of the Grid and the cursor look like after an author has 
typed the word "down" into the Grid:

Clicking the mouse on an unhighlighted Grid Box moves the highlighting there.  Clicking in 
the highlighted Box changes the typing direction (as indicated by the cursor).

The Lower Pane contains a list of Cells.  Each Cell has two Grid Boxes associated with it.  
These Boxes define the beginning and end of the hidden word associated with the Cell.  
When a Cell in the Lower Pane is selected, its associated Grid Boxes are outlined in black.  
The author can change a Cell's associated Grid Boxes by clicking and dragging them with 
the mouse.  When a new Cell is created its default Grid Boxes appear (on top of each other) 
in the Grid.  If the Grid Boxes of a Cell are not in line horizontally, vertically, or diagonally 
Lexica will complain.  Lexica will also complain if a Cell's Grid Box is outside the array of 
letters in the Grid.

6k) CrossWord Sections in Author Mode

In Author Mode the Crossword Sections can be edited by changing, adding, and deleting 
crossword puzzle entries and by adding and removing sounds.

In Author Mode the Upper Pane contains a 25 x 40 Grid that can be edited just like the Grid 
in a Word Search Section.  The only difference is that while Word Search Sections allow 
typing in 8 directions, the Grid in Crossword Sections only enables across and down typing 
directions.

The Lower Pane of a Crossword Section is exactly the same as in an Exercise Section.  
However, Lexica expects each Fillin in the Lower Pane to contain an Author Response that 
matches a crossword puzzle entry in the Upper Pane.  If there is a mismatch, Lexica will 
complain.



6l) Index Section in Author Mode

In Author Mode references can be added to and deleted from the Index Section.

In Author Mode, when Lexica is open to the Index Section, the currently selected Index 
reference can be deleted by issuing a "Delete Index Entry" command (found under the Edit 
Menu).  Index entries can be added by opening the Textbook to the Section that the new 
entry is to refer to and issuing an "Add Index Entry..." command from the Edit Menu.  This 
will bring up the following dialog box:

After the new Index reference title is entered Lexica will confirm that the new entry was 
added by beeping.

7) The Flash Cards in Author Mode

The Flash Cards are disabled in Author Mode.

8) The Dictionary  in Author Mode

An author can add words to a dictionary by typing into the Dictionary's Input Pane and then 
clicking the Add Word Button (see graphic in Getting to Know Lexica).  Similarly, words can 
be removed with the Delete Word Button.  In addition, specially formatted text files of words 
and their translations can be loaded into a Dictionary by using the AutoLoad Button.  (See 
the Lexica Manual for format specifications.)

Pronunciations can also be added to and deleted from any Dictionary entry by using the "Cut
Sound", "Copy Sound", and "Paste Sound" commands in the Edit Menu.  The actual sounds 
must be created with another sound editing application such as SoundEdit™.

Note that the Utility Menu's "Switch Dictionaries...", "Add Word...", "Delete Word", and 
"AutoLoad..." commands are equivalent to the Dictionary's Buttons of the same name.



9) The Help Utility in Author Mode

The Help Utility's Window remains the same in Author Mode as in Student Mode with the 
exception that the Help/List Button is no longer a default Button.

The Help topic title list is not directly modifiable in Author Mode.  However, it can be 
modified, if desired, from outside of Lexica (see the Lexica Manual).

The Help information on specific topics, on the other hand, is completely editable.  When 
Help information is being displayed, changes can be made with standard Macintosh editing 
techniques (and will be saved automatically).


